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TSDS PEIMS Fall Submission Data for
Business

Created: 10/1/2024
Reviewed: 10/30/2025
Revised: 10/30/2025

This document outlines key Business data that is submitted during the Public Education Information
Management System (PEIMS) Fall Submission and used by the Texas Education Agency (TEA). As
the year progresses, this document may be updated to include additional fields of data.

For more information about the TSDS reporting process, review the TSDS Training Materials
webpage:
https://www.texasstudentdatasystem.org/tsds/about/training-and-support/tsds-training-materials

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

Some of the images and/or examples provided in this document are for informational
purposes only and may not completely represent your LEA’s process.

For a complete list of submission rules and edits, access the TSDS Web-Enabled Data
Standards (TWEDS) website:
https://tealprod.tea.state.tx.us/TWEDSAPI/31/0/0/Overview?IntroductionId=993. In the
top-right corner, select the appropriate School Year (20XX), Collection (PEIMS), and
Submission (Fall) and click Open.

Once on the TWEDS website, in the Overview tab, you can review Collections,
Timelines (DUE DATES), and Data Submission Responsibilities. It is highly
important to ensure that you review all of these details as they may change according
to the School Year.

Additionally, you can use the other tabs on the TWEDS website to review Data
Components, Descriptor Tables, References, Rules, Change Logs, and Early
Notices.

https://www.texasstudentdatasystem.org/tsds/about/training-and-support/tsds-training-materials
https://help.ascendertx.com/business/doku.php/academy/business_overview_guide
https://tealprod.tea.state.tx.us/TWEDSAPI/31/0/0/Overview?IntroductionId=993
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Prerequisites

Review the following and take action as needed:

❏ Ensure applicable employees have the correct roles and permissions in ASCENDER Security
Administration to access pages needed for TSDS reporting.

❏ Review TSDS Best Practices for New Employee Records.

❏ Review TSDS Best Practices for Terminated Employee Records.

❏ Create responsibility records in Personnel for staff whose Staff Service begins with “S.” Review
the Responsibilities - Quick Reference Chart.

* The underlined text indicates the domain's submission level as it appears on the District
Administration > Options > TSDS > Domains & Entities page.

I. Education Organization Domain

First Level Submission

Review TSDS Web-Enabled Data Standards for the Education Organization domain.

The Education Organization domain includes information about public, charter, education service
center, organization, or agency.

Information from AskTED is imported into the Operational Data Store (ODS). As you send data,
TEA matches the School ID (county district number) to existing district and campus information
to ensure that the reported data is credited to the correct Local Education Agency (LEA).

Verify district information for current/prior school year.1.

Verify district information for current/prior school year

District Administration > Tables > District Information > District Name/Address

https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_newemployees
https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_termemployees
https://help.ascendertx.com/business/doku.php/academy/responsibilitychart
https://help.ascendertx.com/test/districtadmin/doku.php/tables/districtinformation/districtnameaddress
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❏ In the Year field, type the four-digit school year for which you want to add or retrieve data
and click Retrieve.

❏ Verify the ESC Region Number and ESC County District Number are accurate. The ESC
County District Number is the six-digit ESC county district number assigned by Texas
Education Agency (TEA).

ESC County District Numbers

❏ Click Save for each year; each year is a separate record.

Verify campus information/exclude non-instructional campuses from reporting.2.

Verify campus information/exclude non-instructional campuses from
reporting

District Administration > Tables > District Information > Campus Name/Address

Ensure the Exclude from reporting to TEA checkbox is selected for all non-instructional
campuses/departments to exclude them from being reported to TEA.

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/ed_org_district_info.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/doku.php/general/esc_county_district_numbers
https://help.ascendertx.com/test/districtadmin/doku.php/tables/districtinformation/campusnameaddress
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❏ In the Year field, type the four-digit school year for which you want to add or retrieve data
and click Retrieve. The Year is automatically updated when the Fiscal Year Close process is
completed in Finance.

❏ Retrieve each campus record and confirm that the address and phone numbers are accurate.

❏ Review the following guidelines as consideration for selecting the Exclude from reporting
to TEA checkbox:

Instructional campuses listed in AskTed (001, 041, 101, etc.) should not have the
Exclude from reporting to TEA checkbox selected.
Non-instructional campuses (701, 750, 999, and other campuses or departments needed
for purchasing) should have Exclude from reporting to TEA selected.
Education Service Centers (ESCs): Exclude all campuses from TEA reporting.
Business-only LEAs: Exclude all campuses from TEA reporting.

❏ Click Save for each campus; each campus is a separate record.

Verify Shared Services Arrangements, as needed.3.

Verify Shared Services Arrangements, as needed

District Administration > Tables > District Information > Shared Services Arrangement

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/ed_org_campus_info.png?id=academy%3Afallbusinesspeims
https://tealprod.tea.state.tx.us/tea.askted.web/Forms/Home.aspx
https://help.ascendertx.com/test/districtadmin/doku.php/tables/districtinformation/sharedservicesarrangement
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❏ In the Year field, type the four-digit reporting year for which you want to add or retrieve data
and click Retrieve. For example, the reporting year for the 2025-2026 school year is 2026.

❏ Under Shared Services Arrangements, enter all Shared Services Arrangements for which
the LEA is a member or the fiscal agent. Indicate the Shared Services Type and Fiscal Agent
District ID.

Note: Since each year is entered on this tab, there are not separate tabs for the current
and prior years as in previous years.

❏ Click Save.

II. Staff Domain

Second Level Submission

Review TSDS Web-Enabled Data Standards for the Staff domain.

The Staff Domain includes general staff information for a Local Education Agency (LEA).

This section provides you with a clear view of all the Business fields included in the Staff Domain for
Fall PEIMS reporting. The information is organized by where it exists in the system (application, menu,
page, and tab). This will help you easily locate and correct data as needed.

Personnel1.

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/ed_org_ssa.png?id=academy%3Afallbusinesspeims
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Personnel Report

Personnel > Reports > Personnel Reports > HRS1250 - Employee Data Listing

This report allows you to verify demographic, responsibilities, salary, and account data for
employees, one employee per page.

Use the Include Reports parameter to select Personnel, Job, Responsibility, and Distributions.

TIP: You can also generate user-created reports to assist you in verifying data.

https://help.ascendertx.com/business/doku.php/personnel/reports/personnelreports/employeedatalisting
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_hrs1250parameters.png?id=academy%3Afallbusinesspeims
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https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_hrs1250reportlisting.png?id=academy%3Afallbusinesspeims
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TIP: All new staff should be entered in Personnel and Payroll on the same day by
6pm (if possible). If the required staff data is not available or cannot be entered
the same day, the recommended best practice is to set the Employee Status
field to 0 - Pending to prevent the record from being included in the overnight
extract with incomplete information. Be sure to review TSDS Best Practices for
New Employee Records.

Personnel

Personnel > Maintenance > Staff Demo > Demographic Information

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_hrs1250reportlisting2.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_newemployees
https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_newemployees
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
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When adding new Personnel and Payroll records in ASCENDER, it is highly recommended to
create the records on the same day. This allows the Begin and End Dates to be extracted
correctly during the automatic extract at 6 PM. Verify that the following fields are complete:

Staff ID/SSN
Texas Unique Staff ID
First, Middle, and Last Name
Generation
Sex
DOB
Ethnicity (if applicable)
Race (check all that apply; must select at least one)

Personnel > Utilities > Mass Update > Responsibility

TIP: Before running a mass update, enter an End Date on the responsibility
records for any employees who have been terminated or reassigned. This prevents
ended responsibilities from being copied forward.

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_staff_demo.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/business/doku.php/personnel/utilities/massupdate/responsibility
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❏ Under Parameters, select the appropriate parameters for the employees whose
responsibility data is to be updated.

❏ Under Copy, in the School Year field:

From Type the school year from which you want to copy responsibility records in the YYYY
format.

To Type the school to which you want to copy responsibility records in the YYYY format.

Note: The From School Year is the prior year and the To School Year is the current
year.

❏ Click Execute to execute the process. A preview report is displayed. The report only lists
available responsibilities to be copied based on the set parameters. Duplicates are not allowed.
Review the report.

❏ Click Process to proceed.

A message is displayed indicating that the process was completed successfully.

Personnel > Maintenance > Staff Demo > Responsibility

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/mass_update_responsibility.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/doku.php/general/printreport
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
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Notes:

Employees can have multiple responsibility records for the same year, provided that
each record has a different Staff Service value.
Verify that the School Year for PEIMS Codes is the current PEIMS school year that
you are working in. If the School Year for PEIMS Codes field needs to be updated,
changes can be made on the Personnel > Tables > District HR Options page.

Campus
Co-op/SSA LEA - Co-op staff should be reported by the fiscal agent. Type the nine-digit
ID (six-digit district ID + three-digit campus ID) to identify the LEA (district and campus)
where the SSA/Co-op employees has work assignment records if other than their home
district/campus. If this field is populated, then the Campus field should be blank and vice
versa.
Staff Classification - This field is previously known as Role ID and identifies the
capacity in which a person serves.
ESC/SSA - This field can be blank if it is not applicable.
Staff Service - Refers to the services supplied by staff.
SPED Student Age Range
Pop Served
Monthly Minutes - The total minutes devoted to a particular service in a standard
month. A standard month is the four weeks in October, including the PEIMS Fall snapshot
date (last Friday in October). For example, a class taught for one hour every day would
report 1,200 monthly minutes (60 minutes x 5 days x 4 weeks). This field cannot be

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_responsibility.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/business/doku.php/personnel/tables/districthroptions
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blank, default value is 00000.
# of Students (in class) - This field cannot be blank, default value is 0.
Begin Date
End Date- An end date is not required for the 2025 record unless the employee is
terminated, no longer in the position, or the record should be excluded from the Mass
Update process.

If an End Date is entered, the record will not be copied from 2025 to 2026 during
the year-to-year Mass Update.
If the employee is continuing in the same position, create a 2026 record so it will be
included in the submission.

TIPS:

Responsibility records with a Staff Service that begins with SE must have
Pop Served set to 06.
Responsibility records for aides must have Number of Students set to 0.

Personnel > Maintenance > Employment Info

To ensure that an employee's TSDS Days Employed Set is calculated correctly and to prevent

https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_employment_info.png?id=academy%3Afallbusinesspeims
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employees from being included on the Unaffiliated Staff list in TSDS, verify that the following
fields are complete:

Employee Status - Staff records with a pay type of 1-5, A are extracted for TSDS
reporting if the Employee Status is 1 - Active professional, 2 - Active auxiliary per, 3 -
Retired, 4 - Resigned, 5 - On Leave, or A - Long Term Substitute.
Original Emp Date - The original date on which the individual was employed by the LEA.
Latest Re-Employ Date - Complete this field if the employee worked for the LEA, left
the LEA, and then returned. Note: Do not delete the Original Emp Date but do delete
Termination Date and Termination Reason.
Termination Date - Type the date that the termination of the employee went into effect.
The termination date and reason are used to exclude the employee from TEA reporting.
Termination Reason - Click  to select the reason the employee was terminated. The
termination date and reason are used to exclude the employee from TEA reporting.
Extract for TSDS - Select to include the employee in TSDS Staff Domain extracts
regardless of their employment status. This allows those individuals with a Not
Employed status to be included in the TSDS extract process. This option is useful for job
abandonment instances where a termination date must be entered.
Percent Day Employed - Type the percentage of a standard district workday for which
the employee is hired to work. For an employee on contract, the percentage can be
determined directly from the contract: full-time = 100, half-time = 050, and so on. For a
non-contract employee, the percentage can be determined as follows. For example, the
standard workday for the LEA is 7 hours. An employee is hired to work for 4 hours per
day. This data element is coded as 057 for the employee because 4/7 = .571 is rounded
down. Employees such as cafeteria workers and bus drivers who work only a few hours
each day should not be reported as 100 in this field. Consider the number of hours
worked in relation to the standard LEA workday, not the job. The field can be a maximum
of three digits.
Pct Day Employed Effective Date - Reflects the employee's start date or date of hire or
the effective date of when an employee’s percent day employed is changed.
Highest Degree
Total Years Professional Experience
Total Years Experience In District (professional staff only)
TRA Teaching Experience - Type the two-digit number of verifiable years of teaching
experience as a classroom teacher as described in TEC §48.158. The field default is zero.
TRA Eligibility - Select to indicate the local education agency (LEA) has determined the
teacher (StaffClassification is 087) is employed by a school system and teaches not less
than an average of four hours each day, in an academic instructional setting or a career
and technology educational setting.
Auxiliary Role ID, Begin Date and End Date, if applicable (TSDS = Staff Classification)-
Complete this field for auxiliary staff (not aides) paid from 6129. Only one auxiliary role
should be active at a time. If an employee serves in multiple auxiliary capacities, only the
primary duty should be reported.

For TSDS reporting, leave the End Date field blank until the role officially ends. The end
date should reflect the first day after the last day a non-exempt auxiliary staff was
assigned to the AuxiliaryRoleId descriptor (i.e., the day after the last day the employee
held the position).

Note: Professional and paraprofessional staff may also be reported with an Auxiliary Role

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/dropdown.gif?id=academy%3Afallbusinesspeims
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ID if they serve the LEA in a non-professional or non-paraprofessional role. A classroom
teacher (Staff Classification 087) who also drives a bus route for the school would require
an Auxiliary Role ID to be reported. In this case, the employee would have at least two
payroll accounting entries; one with object code 6119 and one with object code 6129.

As there may be duplication between Staff Classification and Auxiliary Role ID, the LEA
must use its discretion in determining if the employee is serving in a professional or non-
professional capacity.

Paraprofessional Certification, Begin Date and End Date, if applicable - For TSDS
reporting, leave the End Date field blank until the certification expires. The end date
should reflect the day after the last day a para-professional staff was certified (i.e., the
day after the last day that the certification was valid). An employee should generally have
only one active certification for the current year, though a recently expired certification
may still be displayed.

TIPS:

Ensure that all certifications that have ended have an End Date. Delete any
expired certifications from previous years.
To keep historical certification records for reference, move them to the
Personnel > Maintenance > Staff Demo > Credentials tab.

Personnel > Maintenance > TSDS Days Employed Set

This page is used to keep a record of the number of days an employee has been employed
for TSDS reporting purposes and manage begin/end dates if corrections are necessary.

This page only applies to employees with Employee Status 1, 2, 3, 4, 5, or A as listed on the
Personnel > Maintenance > Employment Info page. Each record displays the percent of day
employed, the TSDS number of days employed, the begin and end dates, a date timestamp
indicating when the record was created, and the module within the system where the update
originated. A record is created whenever the number of days employed or percent of day
employed is changed. Only one record without an end date is allowed. Note that the # of
Days Employd will be calculated each day during the automatic extract at 6 PM even if a
manual extract and send is executed in District Administration.

This information is reported in the TSDS
StaffEducationOrganizationEmploymentAssociation>DaysEmployedSet and records the
percent and number of days employed by the employee as well as the begin date and end
date associated with the PercentDaysEmployed and NumberDaysEmployed data elements.

https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/credentials
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/test/business/doku.php/personnel/maintenance/employmentinfo
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Payroll2.

Payroll

Payroll > Maintenance > Staff Job/Pay Data > Job Info

Job Code
Total - This field must be completed for employees with pay types 1, 2, and 3. For Pay
Type 3 (hourly employees), enter an estimate of the annual salary.
Calendar/Local Info
Begin Date and End Date
# of Days Employd: Note that the # of Days Employd will be calculated each day
during the automatic extract at 6 PM even if a manual extract and send is executed in
District Administration.

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_tsdsdaysemployed.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/jobinfo
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_job_info.png?id=academy%3Afallbusinesspeims
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The TSDS Days Employed Set consists of the Percent Day Employed in
Personnel and the # of Days Empld in Payroll. You can verify these days on
the Personnel > Maintenance > TSDS Days Employed Set page.

(If applicable) Exclude Days for TEA - If an employee has multiple jobs listed on this
page, the system automatically calculates the total number of days worked across all
jobs. For example, if a teacher works 187 days and has a secondary job as a bus driver for
180 days, by default, the system adds all days for a total of 367 days. This does not
accurately reflect the actual number of days worked since the employee does not actually
work 367 days. To ensure accurate reporting, it is recommended to only report the job
with the highest number of days. For jobs with fewer days, select Exclude Days for TEA
to prevent those days from being included in the total.

Position Management3.

Position Management

Position Management > Maintenance > PMIS Position Admin

Ensure the Exclude Days for TEA checkbox is selected for all secondary jobs.

The Exclude Days for TEA checkbox can be found on the following Position Management >
Maintenance pages:

PMIS Position Admin > Position Record
PMIS Position Modify > Position Record

https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/positionmanagement/maintenance/pmispositionadmin/positionrecord
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_pmis.png?id=academy%3Afallbusinesspeims
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PMIS Positions History > History
PMIS Change in Position > Change in Compensation

District Administration4.

District Administration

District Administration > Tables > District Information > District Name/Address

Add data for contracted instructional staff as needed.

❏ In the Year field, type the four-digit school year for which you want to add or retrieve data
and click Retrieve.

❏ Under Contracted Instructional Staff, add records and complete the following fields:

Campus
Program Intent Code - Identifies the cost of instruction and other services directed
toward a particular need of a specific set of students. The intent (the student group
toward which the instructional or other service is directed) determines the
CIStaffProgramIntent, not the demographic makeup of the students served.
Number of FTEs - A standard measurement of the portion of professional contracted
instructional staff expressed as a multiple of the standard workday, such as 7.7 FTEs.
When calculating contracted instructional staff FTEs, the following items must be
considered:
The percent of the day worked (the number of hours worked divided by the number of
work hours in the standard day).

https://help.ascendertx.com/test/districtadmin/doku.php/tables/districtinformation/districtnameaddress
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_district_info.png?id=academy%3Afallbusinesspeims
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The percent of days per week worked (the number of days worked divided by 5).
The percentage of weeks worked (the number of weeks worked divided by the number of
weeks in the work year).

For example, Mrs. Jones is hired on a contracted instructional staff basis to teach the tuba to
three tuba players. Her contract specifies that she will work two hours each Monday and
each Friday for the entire school year. Her FTE is 0.25 (two hours worked divided by the
eight-hour work day in the district) multiplied by 0.40 (two days divided by five days)
multiplied by 1.0 (36 weeks worked divided by the 36-week instructional year), for a
reported FTE of 0.10.

Note: For information regarding Full-Time Equivalent (FTE) calculations, please refer to the
TWEDS website.

District Administration > Maintenance > Non-Employee

For contracted instructional staff, complete all fields under Instructional Staff.

https://help.ascendertx.com/test/districtadmin/doku.php/maintenance/nonemployee
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❏ Be sure to select a TSDS Staff Type code for all non-employees who have a start date within
the PEIMS school year that you are currently working in.

• Select 3 - Contracted Professional Staff if the staff member is a Contracted Professional
(instructional and non-instructional).

• Select 4 - In-District Charter Prtnr Campus Teacher if the staff member is a teacher employed
at an In-district Charter Partner Campus.

Notes:

Typically for staff paid out of Finance, not Payroll.
A non-employee cannot have the same Social Security Number and Texas Unique
Staff ID as an active employee in Personnel or Payroll.

Full-time equivalents (FTEs) are calculated in the following manner:

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/staff_domain_non_employee.png?id=academy%3Afallbusinesspeims


District Administration

2025/12/05 18:22 20 TSDS PEIMS Fall Submission Data for Business

If NumberDaysEmployed is greater than or equal to 187, then FTE =
PercentDayEmployed divided by 100.
If NumberDaysEmployed is less than 187, then FTE = (PercentDayEmployed divided
by 100) X (NumberDaysEmployed)/187

Base Salary is the total of all PayrollAmount where PayrollActivity is 80 (Base Salary).

FTE Salary is Base Salary divided by FTE.

District Administration > Maintenance > Non-Employee > TSDS

Create TSDS/Responsibility records for non-employees. Note that any updates made to the Non-
Employee tab will not create new records on this tab.

Note: Non-employees can have multiple responsibility records for the same year, provided
that each record has a different Staff Service value.

III. Finance Domain

Third Level Submission

https://help.ascendertx.com/test/districtadmin/doku.php/maintenance/nonemployee/tsds
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/tsds_non-employee.png?id=academy%3Afallbusinesspeims
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Review TSDS Web-Enabled Data Standards for the Finance domain.

The Finance domain includes financial information captured in accounts (both actuals and
budgeted).

Add crosswalks.1.

Add crosswalks

Finance > Tables > TSDS Crosswalks

Map financial data from the LEA's set of accounts to TEA's Chart of Accounts for both the
current and previous file IDs.

Verify the TSDS crosswalks are correct.
Verify that there are not crosswalks for the automatic crosswalks processed by
ASCENDER.
Review the Automatic Crosswalks section on the Finance TSDS Crosswalk Tables
page.

If a crosswalk is created on this page, it will be used and applied
throughout the TSDS reporting process.
Automatic crosswalks are applied AFTER crosswalks created on this
page are applied.
If you choose to use crosswalks, note that no updates are made to the
Finance application. Any updates must be made manually in the
Finance application.

https://help.ascendertx.com/business/doku.php/finance/tables/tsdscrosswalks
https://help.ascendertx.com/business/doku.php/general/finance_tsdscrosswalk_tables
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As an example, a one-campus LEA that budgets and books expenditure records to
campuses 101 and 001 should establish a crosswalk to move expenditures from
Organization code 101 to Organization code 001.

TIP: When performing a crosswalk, note that it transfers all items from the
old to the new. For example, if using 040 Budget - From Org to Org and you
move Org 101 to Org 001, all line items from Organization code 101 will be
moved to Organization code 001, not just a specific line item.

Verify Budget data.2.

Verify Budget data

Budget data is extracted from Finance for applicable funds. The totals include entries
made into the system until the end of October or accounting period 10. It is

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/finance_domain_crosswalks.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/finance_domain_crosswalk_example.png?id=academy%3Afallbusinesspeims
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recommended that all budget amendments be entered by the PEIMS Fall Snapshot date,
which is the last Friday in October.

The following data is reported:

Fund
Function
Object

Report 5XXX-8XXX
61XX are collapsed into 6100, 62XX into 6200, 63XX into 6300, etc.

Organization
Fiscal Year
Program Intent
Amount
Begin & End Date (time/date stamp assigned at the time of data entry; not the
transaction date)

District Administration > Tables > District Information > Fall Finance TSDS Data

This tab is used to retrieve and edit Fall TSDS financial data, allowing for corrections to
Budget and Payroll data in the TSDS staging tables. The staging area temporarily holds
data before it is submitted to the Texas Education Agency (TEA) (i.e., promoted to the
Operational Data Store (ODS)).

The data on this tab is obtained from the latest Fall extracts after period 10 is closed,
incorporating all TSDS crosswalks, automatic crosswalks, and data summaries.

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/finance_domain_general_ledger.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/doku.php/tables/districtinformation/fallfinancetsdsdata
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Accounts are summarized by fund, function, object class (6100), organization, and
program intent code. For instance, 199-11-6119.00-001-511000 will display as 199 11
6100 001 11. Users should cross-reference balances with the Finance application and
may need to combine amounts to ensure accurate budget reporting.

Notes:

This tab becomes available for editing the day after accounting period 10 is
closed in Finance.
Data cannot be duplicated. Duplicated data will receive an error upon
submission.
Enter data carefully on this tab. Incorrect or improperly formatted data may
cause errors upon submission.

Finance TSDS Crosswalk Tables

❏ Click  to select 1 - Budget.

❏ In the Unique Staff ID field, type the 10-digit unique staff ID assigned to the staff
member by the Texas Education Agency and click Retrieve.

❏ Make any necessary budget corrections (such as code or amount changes) to the
Budget data in the TSDS staging tables.

❏ Click Save.

Notes:

Budget Data with an ODS ID

To delete a previously submitted record, set its amount to zero and insert a
new record with the correct data. This will mark the record for deletion and
resubmission.
Account codes (rows) are validated to prevent duplicate records.

Change Original Record New Record

Account Code or Begin
Date

Status = R - Resubmit, Action = D -
Delete

Status = N –
New, Action = I -
Insert

Amount or End Date Status = R - Resubmit, Action = U –
Update

https://help.ascendertx.com/business/doku.php/general/finance_tsdscrosswalk_tables
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/fallfinancetsdsdata_budget.png?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/dropdown.gif?id=academy%3Afallbusinesspeims
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Change Original Record New Record

Amount = 0 (zero) Status = R – Resubmit, Action = D -
Delete

Records without an ODS ID

Changes will not affect the Status or Action (Status = N - New, Action = I -
Insert).

Verify Payroll data.3.

Verify Payroll data

Payroll > Maintenance > Staff Job/Pay Data > Distributions

Verify all account codes, amounts, and activity codes. All employees should have at least
one row with Activity Code 78 (non-salary) or 80 (Base Salary).

Note: Activity Code 78 is generally used for Volunteer Services where there is zero
pay. If pay should be reported, use valid Activity Codes such as 02, 79, or 80.

The following data is reported:

Amount - Indicates the dollar value paid to a staff member for a given payroll
activity per year.

https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/distributions
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/finance_domain_distributions_tab.png?id=academy%3Afallbusinesspeims


District Administration

2025/12/05 18:22 26 TSDS PEIMS Fall Submission Data for Business

Account Code -
Fund - Identifies the fund group and specific fund (when applicable) for the
staff payroll financial data.
Function - Identifies a general operational area and groups together related
activities.
Object - Identifies an account, a transaction, or a source of funds. It indicates
the major account group to which a transaction is posted or the associated
monies are related.
Organization - Identifies the unique organizational unit within the local
education agency with which the account is associated. For campuses, this is
the three-digit campus number registered with the Texas Education Agency.
For non-campuses, this must be one of the administrative units required in
the Resource Guide, or 998 or 999.
Fiscal Year - The last digit of the fiscal year (e.g., the fiscal year is 6 for the
2025-2026 fiscal year).
Program Intent - Identifies the cost of instruction and other services
directed toward a particular need of a specific set of students. The intent (the
student group toward which the instructional or other service is directed)
determines the PayrollProgramIntent, not the demographic makeup of the
students served.
Activity Code - Indicates the types of duty for which a staff member receives
a salary, salary supplements, or bonuses. PayrollActivity does NOT include
fringe benefits such as group health and life insurance, workmen's
compensation, sick leave, and others under Object value 6140.

District Administration > Tables > District Information > Fall Finance TSDS Data

This tab is used to retrieve and edit Fall TSDS financial data, allowing for corrections to
Budget and Payroll data in the TSDS staging tables. The staging area temporarily holds
data before it is submitted to the Texas Education Agency (TEA) (i.e., promoted to the
Operational Data Store (ODS)).

The data on this tab is obtained from the latest Fall extracts after period 10 is closed,
incorporating all TSDS crosswalks, automatic crosswalks, and data summaries.
Accounts are summarized by fund, function, object class (6100), organization, and
program intent code. For instance, 199-11-6119.00-001-511000 will display as 199 11
6100 001 11. Users should cross-reference balances with the Finance application and
may need to combine amounts to ensure accurate budget reporting.

Notes:

This tab becomes available for editing the day after accounting period 10 is
closed in Finance.
Data cannot be duplicated. Duplicated data will receive an error upon
submission.
Enter data carefully on this tab. Incorrect or improperly formatted data may
cause errors upon submission.

❏ Click  to select 2 - Payroll.

https://help.ascendertx.com/test/districtadmin/doku.php/tables/districtinformation/fallfinancetsdsdata
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/dropdown.gif?id=academy%3Afallbusinesspeims
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❏ In the Unique Staff ID field, type the 10-digit unique staff ID assigned to the staff
member by the Texas Education Agency and click Retrieve.

❏ Make any necessary payroll corrections (such as code or amount changes) to the
Payroll data in the TSDS staging tables.

❏ Click Save.

Notes:

Payroll Data with an ODS ID

To delete a previously submitted record, set its amount to zero and insert a
new record with the correct data. This will mark the record for deletion and
resubmission.
Account codes (rows) are validated to prevent duplicate records.

Change Original Record New Record

Account Code or Begin
Date

Status = R - Resubmit, Action = D -
Delete

Status = N –
New, Action = I -
Insert

Amount or End Date Status = R - Resubmit, Action = U –
Update

Amount = 0 (zero) Status = R – Resubmit, Action = D -
Delete

Records without an ODS ID

Changes will not affect the Status or Action (Status = N - New, Action = I -
Insert).

IV. TSDS Level 1 Errors

This page is used to view and print a listing of Level 1 errors that occurred in various
domains/entities when the API interface files begin processing into the TEA database.
ASCENDER does not control the content of these errors.

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/fallfinancetsdsdata_payroll.png?id=academy%3Afallbusinesspeims
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All TSDS Level 1 Error reports are displayed and printed in landscape orientation by default.

Review/correct TSDS Level 1 Errors.1.

Review/correct TSDS Level 1 Errors

District Administration > Inquiry > TSDS Level 1 Errors

Review TSDS Level 1 errors on a regular basis and correct data as needed. If not
addressed, these errors will prevent data from flowing to the Operational Data Store
(ODS).

You can print various reports using the following options:

Select the checkbox next to the domains (rows) to be included in the report and
click Print. This prints errors associated with the selected Domain > Entity.
Click Extract Errors Reprint to display the processes that completed successfully
in the last extract as well as a list of errors that need to be corrected. This should be
the focus for most error resolution.
Click Extract Prior Year Reprint to display data that was extracted for Mid-Year
PEIMS.
Click Extract Budget Reprint to display Budget data most recently extracted for
Fall PEIMS.
The Extract Payroll Reprint button displays Payroll data most recently extracted
for Fall PEIMS.

Note: If included in the report, the Action Type column displays the expected action
of the record that was sent to the Operational Data Store (ODS):

I - Insert
U - Update
D - Delete

https://help.ascendertx.com/test/districtadmin/doku.php/inquiry/tsdslevel1errors
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/general/fall_business_level_1_errors.png?id=academy%3Afallbusinesspeims
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V. Data Quality Tips

To easily locate a complete list of valid codes, you can copy and paste the table ID
into the Search For field on the TWEDS website and click Search.

TSDS Data Quality Checklist

Budget Data

ASCENDER
Breadcrumb

Step

Finance >
Inquiry >
General Ledger
Inquiry

Click  to display all funds. Verify all funds are valid for the 2026 Budget. If
not, create TSDS Crosswalks (Fund to Fund).

BudgetFund - Table ID C145B
Click  to display all functions. Verify all functions are valid for the 2026
Budget. If not, create TSDS Crosswalks (Function to Function).

TIP: Expense function codes should not be 00.

BudgetFunction - Table ID C146B
Click  to display all objects. Verify all objects are valid for the 2026 Budget. If
not, create TSDS Crosswalks (Object to Object).

TIP: Expense object codes should not end with 0.

BudgetObject - Table ID C159B
Click  to display all Program Intent Codes (PICs). Verify all PICs are valid for
the 2026 Budget. If not, create TSDS Crosswalks (Program Intent to Program
Intent).

TIP: Expense program intent code should not be 00.

BudgetProgramIntent - Table ID C147B
Click  to display all organization codes. Verify all organization codes are valid
for the 2026 Budget. If not, create TSDS Crosswalks (Org to Org).
Verify organizations 001-698 are tied to a campus ID in AskTED. If not, create
TSDS crosswalks as needed (Org to Org).
Click  to verify accounts with PIC 91 are using function codes 36, 51 or 52.

https://help.ascendertx.com/business/doku.php/finance/inquiry/generalledgerinquiry/generalledgerinquiry
https://help.ascendertx.com/business/doku.php/finance/inquiry/generalledgerinquiry/generalledgerinquiry
https://help.ascendertx.com/business/doku.php/finance/inquiry/generalledgerinquiry/generalledgerinquiry
https://help.ascendertx.com/business/doku.php/finance/inquiry/generalledgerinquiry/generalledgerinquiry
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
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ASCENDER
Breadcrumb

Step

Click  to verify combinations:

• Org 701-750 should only be used in functions 41, 53, 99
• Function 71 should be used with object 65XX
• Funds 205, 255, 270, 429 should be used with PIC 24 rather than 30
• Expense objects (6XXX) should not be used with Org 000, 709-719, 726-749
or 800-997
• Expense Objects (6XXX) should not be used with PIC 00
• Expense Objects (6XXX should not use function 00)

Account Code Matrices in FAR
Click  to verify the fiscal year for PEIMS Budget Funds. The fiscal year is 6 for
the 2025-2026 fiscal year. (Only applies to funds reported for Fall PEIMS: 199,
240, 420, 599)
Verify expenditures exist for object code 6491 to record Statutorily Required
Public Notices.
Verify at least one account code exists for instructional staff development
(function 13) with budget amounts.
Verify at least one account code exists for general administration (function 41)
with budget amounts greater than zero.
Verify at least one account code exists for instructional resources and media
services (function 12 and object 6100-6600) with a budget and actual
expenditures greater than zero.
Verify at least one account code exists for guidance, counseling, evaluation
services or social work services or health services in function 31-33, object
6100-6600 with amounts greater than zero.
Verify at least one account code exists with object code 6212 for audit
services.
Verify one account code exists for Matching State Funds (object 5829) in funds
240 and 410.
Verify budgets in object 65XX are tied to function 71.

Staff Data

Active Employees:

ASCENDER
Breadcrumb

Step

Personnel >
Maintenance >
Staff Demo >
Demographic
Information

Verify the following fields are completed for all regular employees,
contracted instructional staff, and long-term substitutes:

• Texas Unique Staff ID
• DOB
• Sex
• Race
• Ethnicity

Generate a user-created report to verify accuracy.

Staff Entity

https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://tea.texas.gov/finance-and-grants/financial-accountability/fasrg/fasrg19-module1-far-appendices.pdf
https://help.ascendertx.com/test/districtadmin/lib/exe/detail.php/images/smallpicklist.gif?id=academy%3Afallbusinesspeims
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
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ASCENDER
Breadcrumb

Step

Personnel >
Maintenance >
Staff Demo >
Credentials

Ensure the PK Teacher Specialization is added to all PK Teachers of Record.

PK Teacher Requirement - Table ID C207

Ensure all TIA teachers have TIA data added. If TIA eligible, generate a user-
created report to ensure they also have Creditable Years of Service. This
is reported in Class Roster.

TIA Designation - Table ID C322

Personnel >
Maintenance >
Staff Demo >
Responsibility

Ensure Responsibility records are complete and accurate for applicable staff.

StaffEducationOrganizationAssignmentAssociation Entity

Responsibilities - Quick Reference Chart
Responsibility records with a Staff Service beginning with SE must have
Pop Served set to 06.

Population Served - Table ID C030
Responsibility records for aides must have Number of Students set to 0.

Personnel >
Maintenance >
Employment Info

Verify that active employees only have one employment type selected,
Employment Type or Retiree Employment Type.

Staff Type - Table ID C181
Verify Employee Status is 1-5 or A when data is ready to be sent. (TIP: It is
recommended to set the Employee Status to 0 - Pending while gathering
required data elements.

TSDS Best Practices for New Employee Records
Verify all employees with a Latest Re-employment Date do not have a
Termination Date. For re-hires, delete the Termination Date and
Reason.
Verify all regular employees have a Highest Degree.
Verify all employees have a Percent of Day Employed.
Verify professional staff have Total and In District years of experience.
(exclude current year in count)

Total Years Professional Experience
Verify all auxiliary staff have an Auxiliary Role ID with a Begin Date. Staff
who have an Auxiliary Role ID should have at least one payroll record
coded to object code 612X.

Auxiliary Role - Table ID C213
Verify all paraprofessional staff with a Paraprofessional Certification have
Para Cert selected with a Begin Date.

Paraprofessional Certification

https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/credentials
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/credentials
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/credentials
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/credentials
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
https://help.ascendertx.com/business/doku.php/academy/responsibilitychart
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_newemployees
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ASCENDER
Breadcrumb

Step

Verify Employment Status. Only staff with an Employment Status of
01-05 and A are reported to PEIMS. When all employee data is complete and
accurate, change the Employment Status to include the record in the
nightly send job.

TSDS Best Practices for New Employee Records
Personnel >
Maintenance >
TSDS Days
Employed Set

Ensure all reported staff have Number of Days Employed.

StaffEducationOrganizationEmploymentAssociation Entity

Ensure all reported staff have a Percent of Days Employed.

StaffEducationOrganizationEmploymentAssociation Entity

Terminated Employees:

ASCENDER Breadcrumb Step

Personnel > Maintenance >
Employment Info

Verify the employee record has a Termination Date and
Termination Reason.

TSDS Best Practices for Terminated Employee Records
Verify the employee record has an End Date for the Auxiliary
Role ID and/or Paraprofessional Certification.
Select Extract for TSDS to include the employee in TSDS Staff
Domain extracts regardless of their employment status.
Verify the employee record has an updated Employment
Status, if not, select the appropriate code.

Personnel > Maintenance >
Staff Demo > Responsibility

Verify the employee record has an End Date on the
Responsibility record if one exists.

TSDS Best Practices for Terminated Employee Records
Payroll > Maintenance > Staff
Job/Pay Data > Pay Info Verify the employee record has an Inactive Pay Status.

Personnel > Maintenance >
TSDS Days Employed Set Verify the employee record has an End Date.

Payroll Data

ASCENDER
Breadcrumb

Step

Payroll > Reports >
User Created Report

Review employee distributions. Verify organization codes on all payroll.
No payroll expenditure codes should use org 000, 700, 709-719,
726-749, or 800-997.

Account Code Matrices in FAR
Verify admin staff coded to functions 41, 53, or 99 use valid org codes
701-750.

Account Code Matrices in FAR

https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_newemployees
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_termemployees
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/responsibility
https://help.ascendertx.com/business/doku.php/academy/tsds_bestpractices_termemployees
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/payinfo
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/payinfo
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/personnel/maintenance/tsdsdaysemployedset
https://help.ascendertx.com/business/doku.php/payroll/reports/usercreatedreports/hrreport
https://help.ascendertx.com/business/doku.php/payroll/reports/usercreatedreports/hrreport
https://tea.texas.gov/finance-and-grants/financial-accountability/fasrg/fasrg19-module1-far-appendices.pdf
https://tea.texas.gov/finance-and-grants/financial-accountability/fasrg/fasrg19-module1-far-appendices.pdf
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ASCENDER
Breadcrumb

Step

Verify program intent codes on all payroll. No payroll program intent
codes should use org 00.

Account Code Matrices in FAR
Verify all staff have at least one payroll code with a Payroll Activity
code of 80.
Staff paid with object 6129 must have an Auxiliary Role ID or
responsibility with Staff Classification of 033 or 036 or Classroom
Position record of 05 in the Schedule.

Personnel > Tables >
Salaries > Extra Duty

Verify Business Allowances are set to Activity Code 79.

PayrollActivity - Table ID C018

The District PEIMS Coordinator is responsible for setting up the following, unless
other arrangements have been established.

Do not make changes to this information unless authorized.

ASCENDER Breadcrumb Step
District Administration >
Options > TSDS > Options

Verify that the As-of-Date and School Start Window (SSW)
Date fields have the correct dates.
Ensure that email address(es) are entered under Finance
Extract Distribution List and Personnel/Payroll Extract
Distribution List. These designated email addresses allow a
person or group of persons to receive extract emails.

District Administration >
Options > TSDS > Connection Verify the API URL, Key, and Secret are accurate.

District Administration >
Options > TSDS > Domains &
Entities

Make selections on Domains & Entities as described in the
ASCENDER TSDS New School Year Best Practice Guide.

https://tea.texas.gov/finance-and-grants/financial-accountability/fasrg/fasrg19-module1-far-appendices.pdf
https://help.ascendertx.com/business/doku.php/personnel/tables/salaries/extraduty
https://help.ascendertx.com/business/doku.php/personnel/tables/salaries/extraduty
https://help.ascendertx.com/districtadmin/doku.php/options/tsds/options
https://help.ascendertx.com/districtadmin/doku.php/options/tsds/options
https://help.ascendertx.com/test/districtadmin/doku.php/options/tsds/connection
https://help.ascendertx.com/test/districtadmin/doku.php/options/tsds/connection
https://help.ascendertx.com/test/districtadmin/doku.php/options/tsds/domainsandentities
https://help.ascendertx.com/test/districtadmin/doku.php/options/tsds/domainsandentities
https://help.ascendertx.com/test/districtadmin/doku.php/options/tsds/domainsandentities
https://help.ascendertx.com/districtadmin/doku.php/academy/district_admin_newsy_best_practice_gde
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